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Module 01

“Computers are to design as microwaves are 
to cooking.” 

– Milton Glaser
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AC T I V I T Y  |  R E SE A R CH:  PR I N CI PL E S  O F  D E SI G N  PH OTO  SU R V E Y  (1  O F  4)
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AC T I V I T Y  |  R E SE A R CH:  PR I N CI PL E S  O F  D E SI G N  PH OTO  SU R V E Y  (2  O F  4)
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AC T I V I T Y  |  R E SE A R CH:  PR I N CI PL E S  O F  D E SI G N  PH OTO  SU R V E Y  (3  O F  4)
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AC T I V I T Y  |  R E SE A R CH:  PR I N CI PL E S  O F  D E SI G N  PH OTO  SU R V E Y  (4  O F  4)
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AC T I V I T Y  |  R E SE A R CH:  PR I N CI PL E S  O F  D E SI G N:  PR O FE SSI O NA L  G R A PH I C  D E SI G N  E X A M PL E S

Focal Point | The focal point is the flower, which is larger than 
any other object in the picture except for the hand, though the 
flower still gains the viewer’s attention due to its bright red color.

Proximity | The buttons on the VHS player are grouped together 
for the sake of organization

Visual Hierarchy | My eyes are drawn first to the cow, then to the 
girl, then to the stinky cheese man.  It took me a while to notice 
the screaming boy in the top left corner, though.

Alignment | The keys are aligned not only in straight lines, but 
also in a paattern that allows the fingers to flow over them.
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AC T I V I T Y  |  R E SE A R CH:  PR I N CI PL E S  O F  D E SI G N:  PR O FE SSI O NA L  G R A PH I C  D E SI G N  E X A M PL E S

Scale Contrast | The numbers are the biggest part of the license 
plate, giving more attention to them.

Negative Space This illustration in the storybook emphasises 
in the middle of the empty space, with the matador entering 
above.

Asymetrical Balance | Harry potter is not symmetrical, but it 
flows well.

Overlapping | The carpet pattern comprises of overlaping 
circles.



A R T  130 |  I N T R O D U C T I O N  TO  G R A P H I C  D E S I G N  |   8A A R O N  CO W L E Y

AC T I V I T Y  |  P O N D ER:  M O D U L E  01

Hi my name is Aaron Cowley, and 
my most distinguishing feature is 
my interest in computer science and 
information technology.

Where did you come from, before BYU-Idaho? 

I came from American Heritage School, and attended 
BYU Idaho briefly before my mission, which I served in 
the Family and Church History Headquarters mission.

Why are you here, at BYU-Idaho? 

I came here to recieve training for the rest of my life, 
mainly web design and development.  I also came here 
because it is one of the few universities where religious 
learning is as emphasized as secular learning.

An interesting 
fact about 
yourself. (3-5 
lines)

Where are you going, 
after BYU-Idaho 

I hope to be employed 
with ancestry or 
familysearch, and do some 
indy-game development 

on the side.

Why are you taking this class and what do you hope 
that it will do for you? 

I hope to become better at visual design so that I can 
make my web pages, logos, and other designs visually 
appealing.

PRINCIPLES OF DESIGN: PHOTO SURVEY

What was your experience like completing the 
photographic design principle survey? 

It took longer than what I thought it was.  I took a lot of 
picture that I thought represented some design principle 
in some way (way more than 30) and fit one to each box.  
I had to go back and take even more pictures after some 
time.

PRINCIPLES OF DESIGN: PROFESSIONAL EXAMPLES

What was your experience completing the activity 
searching for design principles in professional 
design examples?

A lot easier than searching for things around the house 
to photograph.  The internet is magic.

CONCLUSION
I’m tardy, but always there!

Aaron Cowley
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Module 02

“Don’t try to be original, just try to be good.” 

– Paul Rand
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P R O J E C T  1  |  SHA PE S:  T H UM B NAI L S

1

2

3

1.	 Write a caption for your 1st 
selection. The first dot is in place 
to show how they should be 
placed. What design principles 
did you use?

2.	 Write a caption for your 2nd 
selection. What design principles 
did you use?

3.	 Write a caption for your 3rd 
selection. What design principles 
did you use?

Row 2, Column 1
I use contrast and 
only two shapes:  
circles and triangles, 
to illustrate a cat’s 
head.

Row 3, column 3
I use overlap to 
overlap a trinangle, 
a black line, a circle, 
and a square each to 
create two spotlights, 
also overlaping each 
other, with lines to 
further illustrate this.

Row 3, column 2
I use lines to il-
lustrate an invis-
ible square through 
closure.
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P R O J E C T  1  |  SHA PE S:  T H UM B NAI L S

1

2

3

1.	 Write a caption for your 1st 
selection. The first dot is in place 
to show how they should be 
placed. What design principles 
did you use?

2.	 Write a caption for your 2nd 
selection. What design principles 
did you use?

3.	 Write a caption for your 3rd 
selection. What design principles 
did you use?

Row 2, column 6
I use both overlap 
of one rectangle and 
two triangles, and 
upward movement 
to make a rocketship.
row 4, column 5
I use both overlap 
and visual hierarchy 
to create a good-
friday type image.
Row 4 column 2
I use repetition to 
create a checker-
board.
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AC T I V I T Y  |  A D O B E  I L LUS T R ATO R:  BA SI C  SHA PE S

DEPTH FOCAL POINT CONTRAST
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My favorite room in the world is the 
forest because it’s away from all of the 
loudness of the world.

THUMBNAIL SKETCHES 

How long did it take to complete the sketches? 

It took me six straight hours.

How can sketching be to your advantage as a 
designer/web designer? 

Answer It’s easier to draw out shapes on a piece of paper 
or in MS paint than it is to immediately go to it in a more 
advanced drawing program.

Why do you think 48 sketches were assigned?

The more we do it, the better we get at it.

What did you enjoy most about this weeks activities? 

the fact that we learn to enjoy it, even if it’s tedious.  The 
more we enjoy our work, the more productive we are.

quote

ADOBE ILLUSTRATOR ACTIVITY

How comfortable are you with Adobe Illustrator?

Very comfortable.  I can also work with other vector 
programs like Inkscape and Adobe Flash/Animate

What is the biggest advantage of vector art?

You can increase the size as much as you need to, and 
it won’t become “blocky”.  Very useful for logos and 
other illustrations that need variable sizes (like either for 
something as big as a billbord or something as small as a 
postage stamp)

CONCLUSION
This was tedious, but it was necessary.  Sketching out 
or planning anything is not something I am really good 
at.  My tendency is to just immediately go into playing 
around in the design program and pulling something 
out of there.  It also reflects my time management skills, 
sadly.

P O N D E R  |  M O D U L E  02

Have someone take a picture of you sketching. A selfie would be acceptable. 
Use a design principle in the photograph. Write a caption for the photo.
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Module 03

“It’s through mistakes that you actually 
can grow. You have to get bad in order 
to get good.” 

– Paula Scher
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P R O J E C T  1  |  SHA PE S:  R EFI N E M EN T  T H UM B NAI L S

1

2

3

1.	 Write a caption for your 1st 
selection. The first dot is in place 
to show how they should be 
placed. What design principles 
did you use?

2.	 Write a caption for your 2nd 
selection. What design principles 
did you use?

3.	 Write a caption for your 3rd 
selection. What design principles 
did you use?



ART 130 | INTRODUCTION TO GRAPHIC DESIGN |  3AARON COWLEY

P R O J E C T  1  |  S T EP  2:  D I G I TA L  SK E TCH  SE T  01

DESIGN PRINCIPLES USED

1.	 Overlapf

2.	 Focal Point

3.	 grouping

DESIGN PRINCIPLES USED

1.	 Grouping

2.	 Overlap

3.	 Closure

DESIGN PRINCIPLES USED

1.	 Focal Point

2.	 overlap

3.	 closure
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P R O J E C T  1  |  S T EP  2:  D I G I TA L  SK E TCH  SE T  02

DESIGN PRINCIPLES USED

1.	 repetition

2.	 negative space

3. alignment

DESIGN PRINCIPLES USED

1.	 repetition

2.	 closure

3.	 alignment

DESIGN PRINCIPLES USED

1.	 focal point

2.	 overlap

3.	 negative space



ART 130 | INTRODUCTION TO GRAPHIC DESIGN |  5AARON COWLEY

AC T I V I T Y  |  A D O B E  I L LUS T R ATO R:  L AY ER S,  SEL EC T I N G ,  A L I G N M EN T,  A N D  M O R E
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P O N D E R  |  M O D U L E  03

My favorite thing to eat at a restaurant is  
Swiss mushroom burgers. I sometimes 
order the same thing when I go out to 
eat for the sake of variety, or because it’s 
not available.

DIGITAL SKETCHES

What design principles do you keep coming back to? 
Why are you drawn to 
these specific principles?

I am drawn to repetition 
and alignment, because 
it’s orderly, neat.  I prefer 
to create patterns intead of 
“organized chaos”

What did you discover 
about your compositions 
from making variations?

I prefer to make shapes 
that can be recognized 

(like my cat head, made out of simple shapes, or the 
radioactive symbol)

Do any of your digital sketches look like your 
thumbnail sketches?

Yes, though for the sawblade, I added two more squares 
to the composition than to the sketch it was based on.

When creating the digital sketches, did you think 
about design or how to use Adobe Illustrator?

Yes

Adobe Illustrator is (… 3 to 5 lines).

ALIGNMENT ACTIVITY

What is your favorite new thing that you learned 
completing this activity?

More like a review, but layering.  It’s very useful.

What do you need more help with? 

Managing my time wisely so I get this done sooner.

CONCLUSION

ALL’S WELL THAT ENDS WELL.  :3

Place your favorite digital sketch 
here and write a caption about why 
you chose it.
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Module 04

“Working within the constraints of a problem 
is part of the fun and challenge of design.” 

–  Ellen Lupton
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P R O J E C T  1  |  S T EP  3:  D I G I TA L  SK E TCH  SE T  03

DESIGN PRINCIPLES USED

1.	  overlap

2.	 Asymmetry

3.	 closure

DESIGN PRINCIPLES USED

1.	 repetition

2.	 overlap

3.	 asymmetry

DESIGN PRINCIPLES USED

1.	 Focal Point

2.	 overlap

3.	 closure
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P R O J E C T  |  SHA PE S  PR OJ EC T  FI NAL  CO M P OSI T I O N
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AC T I V I T Y  |  A D O B E  I L LUS T R ATO R:  L AY ER S,  SEL EC T I N G ,  A L I G N M EN T,  A N D  M O R E
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P O N D E R  |  M O D U L E  0 4

My favorite pet will be named Mitchelle 
and I loved it when she would rub her 
paw on her head to motion me to pet 
her..

FINAL COMPOSITION PRESENTATION
In the Shapes Composition I created a design that used 
multiple triangles aligned with each other, a line, and a 
circle.

Write a block quote about your 
composition. It may be an excerpt 

from your written presentation. 
(3-5 lines)
(Principle 1) I use repetition to make an infinite line of 
triangles that disappears into the top right corner..

(Principle 2) I use overlap as I stack other shapes into the 
composition.

(Principle 3) I use alignment to make an infinite line of 
triangles that disappears into the top right corner..

In conclusion, repetition, alignment, and overlap. assisted 
in creating a successful composition by (brief concluding 
statement).

ACTIVITY | SOFTWARE TRAINING

What was the most helpful thing you learned this 
week about Adobe Illustrator? 

I learned more about exporting PDF files in illustrator

What do you still want to learn about Adobe 
Illustrator?

Could I use it in conjunction with adobe flash?  Or create 
a cartoon drawing with adobe illustrator?

MODULE 03 REFLECTION
This was the weirdest thing I’ve done.  Making shadows 
with simple shapes, to make a pattern.  My first instinct 
was to make recognizable shapes, like a radioactive 
symbol, a cat head, a star, or a sawblade.  My mind falls 
into patterns, it’s easier to work with them.  pushing that 
is pretty difficult.

CONCLUSION

It’s a weird experience, trying to break away from 
patterns.  But we gotta do it, otherwise we’ll end up 
doing the same old thing.

Final Composition with a caption.
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Module 05

“Content precedes design. Design in the 
absence of content is not design, it’s 
decoration.” 

– Jeffrey Zeldman
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P R O J E C T  |  LO G O:  C AT EG O RY  & T H E M E

Complete this worksheet before you 
begin your research or start sketching 
your logo. Use this page to define the 
problem you will be solving before you 
begin working on the logo itself. The 
success of your logo will be assessed 
according to the information you 
provide here.

COMPANY/EXHIBIT
I would like to make an icon for a science museum

COMPANY/EXHIBIT DETAILS
This museum will feature interactive exhibits on science 
topics like astronomy, human biology, physics, and 
geology

THEME
I shall use the constillation as my theme, and have the 
planetarium be the main attraction

TARGET AUDIENCE 
Families with children, who would be interested in 
taking their children to something fun and interesting to 
educate them about how the world works

MOOD/IDEA CHARACTERISTICS
It should look fun, exciting, and maybe have some 
“space” related thing, like “its out of this world!”

We’re fun, we’re educational, it’s almost like a theme park 
in which you can be enlightened.

COMPANY/EXHIBIT NAME
Alpha Centari Science Fun Labs

COMPANY TAGLINE
Out of this world science center!
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AC T I V I T Y  |  LO G O:  V I SUA L  R E SE A R CH

Collect logo samples in order 
to understand what a good 
logo is. Write a short caption 
for each logo describing why 
you picked it.

1.	 Arizona Science center

2.	 Museum of science

3.	 science museum of minesota

4.	 atom symbol

5.	 Star symbol

6.	 Nasa logo

7.	 space X symbol

8.	 planet

9.	 consetelation

10.	 another atom symbol

11.	 Science museam logo, shows 
waves and shadows

12.	 space adventures

13.	 tomorrowland from Disneyland

14.	 Space mountain from 
Disneyland

15.	 Epcot logo

16.	 National Science foundation

17.	 autism science foundation

18.	 constellation

19.	 datascience foundation

20.	 european science foundation

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

16 17 18 19 20
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P R O J E C T  |  LO G O  C AT EG O RY:  V I SUA L  R E SE A R CH  (PH OTOS  E TC .)
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P R O J E C T  |  LO G O  TO PI C:  V I SUA L  R E SE A R CH  (PH OTOS  E TC .)
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P R O J E C T  |  LO G O  PR OJ EC T:  WO R D  L I S T S

A word list helps you explore ideas. 
Write every word you can think of that 
relates to your compay or exhibit. Make 
sure you fill this page full of words. 
You may need the help of a thesarus 
to complete this task. Once the page is 
full of words take some time to find and 
mark those words that could be turned 
into interesting logo sketches.

Lists

star

planet

quasar

wormhole

neutron

supernova

constellation

stellar

planet

nebula

sirius

centari

alpha

neutron

photon

proton

quark

physics

rocket

spaceship

spacestation

universe

cosmo

cosmological

hadron

lepton

atom

molecular

Ursa Major

Ursa Minor

polaris

andromeda

aquarius

aries

pandora

canis major

centarus

leo

cepheus

orion

pegasus

taurus

virgo

hydra

scorpius

libra

pulsar

milky way

celestial

gamma ray

beta

andromeda

galaxy

Boson

Preon
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P R O J E C T  |  LO G O:  M I N D  M A P

Identify interesting 
connections

1.	 Very frequent use of Greek/
Roman mythology

2.	 Many words would otherwise be 
boring without their connection 
to the real thing (milky way, dark 
matter, big bang)

3.	 planets and moons are named 
after Gods, stars and other 
objects are named after lesser 
characters in ythology

4.	 many words that refer to stars or 
other objects are ordinary words 
in greek or latin.  Which means 
that the classical languages are 
inherently cooler. 

5.	 Little known fact is that Titan 
is a word that refers to the 
predecessors of the olympians, 
but we associate the word with 
“giants” for some reason I’m not 
awre of.

6.	 during my childhood, I 
associated rockets with space 
travel, but apparently they are 
used just as frequently for war.  
Many ICBMs were also used for 
space travel

7.	 I wonder how many fans of the 
movie Avatar are aware that 
Pandora refers not only to the 
radio, but also the Eve character 
from Greek mythology.

8.	 the word “quark” seems to be a 
word that scientists used when 
they ran out of latin and greek 
words to use.  Diddo with most 
particles, though there are roots 
like pro, neu, or neg.
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P R O J E C T  |  LO G O  PR OJ EC T:  S YM B O L  SK E TCH E S

Identify interesting 
connections

1.	 rockets all look the same, but for 
pratical reasons

2.	 Gotta find a good way to 
simplify drawings of animals or 
other figures from mythology.

3.	 the atom, the radioactive 
symbol, the water molecule, all 
on a molecular level, dealing 
with chemistry and nuclear 
chemiestry

4.	 Intersiting to see the 
comparions and contrasts 
between the traditional symbols 
of the moon and stars, and 
how they look like up close 
(star being a ball of hydrogen 
gas undergoing fusion, the 
moon being a rock with no 
atmosphere)

5.	 caption
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AC T I V I T Y  |  A D O B E  I L LUS T R ATO R:  A N  I N T R O D U C T I O N  TO  T H E  PEN  TO O L
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P O N D E R  |  M O D U L E  03

Hi my name is (your name here) and my 
favorite dessert is (fill in the blank).

Why do you conduct research at the begining of a 
design project? 

See what other people have done, or look at real-life 
objects to see which ones you can make a simplified 
doodle off of

What makes a logo good? 

Do the colors look right?  Does it look cool?  What 
creative ways can you use simple shapes to make 
recognizable objects?  How can you rearrange letters?

How many ideas were you able to discover through 
your word lists and mind maps? 

New objects to either name your brand after, or things to 
draw to add into your logo

How many of your sketches combine two different 
objects into a single image? 

Shapes or objects?  Not many, though the final icon will 

likely include multiple shapes from multiple sketches

What is the most difficult part of coming up with 
ideas to sketch? How did you work through this 
difficulty?

Originality.  What do you do 
to make your idea unique?

A blockquote can 
be used to catch 

a readers attention. Choose a 
sentence or two from your writing 
and make it into a blockquote 
using this style.

Wooden Patriotic sign

Little known fact is that Titan is a 
word that refers to the predecessors 
of the olympians, but we associate 
the word with “giants” for some 
reason I’m not aware of.
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Module 06

“Constantly experiment … constantly go 
forward.” 

– Alexey Brodovitch
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LO G O  |  V I SUA L  R E SE A R CH  PAR T  02

Collect logo samples in order 
to understand what a good 
logo is. Write a short caption 
for each logo describing why 
you picked it.

1.	 Nasa, interesting font

2.	 Epcot, integration of graphics 

3.	 Epcot, another variation of Epcot 
icon

4.	 Nasa, use of stars on shapes

5.	 Space Mountain, adding star 
background onto words.

6.	 Space mountain, simple drawing 
of building with text

7.	 Space X, stylized text

8.	 Tomorrowland, interesting use of 
shapes and text

9.	 Soviet space insignia, good use of 
shapes and font

10.	 Space Camp, use of drawings 
and text, space shuttle, stars, and 
american flag

11.	International Space Agency, star 
background with text

12.	 Space Shuttle insignia

13.	 Model Rocket logo

14.	 Collect Space icon

15.	 Young Collins

16.	 ursa major

17.	big dipper

18.	polaris

19.	Saturn

20. galaxy

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

16 17 18 19 20
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S T U D I O  |  LO G O  PR OJ EC T:  R E V I SED  LO G O  SK E TCH E S

Identify interesting 
connections

1.	 Rocket ships

2.	 Instruments used to measure/
study celestial bodies and other 
objects

3.	 Planets

4.	 stars

5.	 galaxies
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AC T I V I T Y  |  A D O B E  I L LUS T R ATO R:  M O R E  PR AC T I CE  W I T H  T H E  PEN  TO O L
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S T U D I O  |  LO G O  PR OJ EC T:  D I G I T IZED  LO G OS

Original Sketch

Logo Option A Logo Option B Logo Option C

Original Sketch Original Sketch
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P O N D E R  |  M O D U L E  06

My favorite snack to munch on while 
designing is ice cubes because it helps 
me to relieve stress.

How did this second round of sketching affect your 
logo ideas? 

Not much, except I’m draing more complex shapes.  
Mostly shapes comprised of many smaller ones

How did you choose which logos to digitize? 

I chose the logos that I think I would be able to combine 
into a larger one

What new things did you learn about Adobe 
Illustrator while digitizing your logos? 

Mostly a review, but I reviewed how to combine shapes, 
etc

What was the most difficult thing about digitizing 
your logos? 

Mostly my sketches were to give me an idea of what I 

wanted, not what I’d trace.  For tracing, I’d use photos.

Are your digitized logos better than your sketches or 
are your sketches better than your digitized logos? 
Why?

My digitized logos are better because it’s easier for me to 
make precise shapes with the tools in illustrator than it is 
to make them with a paper and pencil.

My favorite logo is the Space 
Mountain logo with the creative 
font and starry pattern on it.

Take a photograph of your favorite snack to eat while designing. Crop it and 
add it to this page with a caption.
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Module 07

“A designer knows he has achieved 
perfection not when there is nothing left to 
add, but when there is nothing left to take 
away.” 

– Antoine de Saint-Exupéry
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P R O J E C T  |  LO G O  PR OJ EC T:  R EFI N E M EN T S

Best Logos

1.	 Combined my three illustrations from the last module to create one

2.	 Shifted the window and earth to show off constilations better

3.	 changed the constilation to alpha centari

1. 2. 3.
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1.

5.

2.

6.

3.

7.

4.

8.
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9.

13.

10.

14.

11.

15.

12.

16.
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S T U D I O  |  LO G O  PR OJ EC T:  CO LO R  VA R IAT I O N S  PA R T  01 O F  02

1.

5.

2.

6.

3.

7.

4.

8.
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9.

13.

10.

14.

11.

15.

12.

16.
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P O N D E R  |  M O D U L E  07

My favorite color is black because it’s 
easy on my eyes.

Which typefaces worked best with your logo? Why? 

Serpentine and Spacera LT, because they give the 
best vibe of “space tech” theme.  Red Seven is too 
“themeparkish”, and Data 70 is too cliche.

Can typefaces have personalities? How? 

Oh yes.  It can give off a vibe of a theme, like sci fi, wild 
west, roman, victorian, etc

What did you learn about value contrast? 

It’s more difficult than it looks.  Colors on the same set 
most definitely don’t have the same value.

Why do logos usually only use one or two colors? 

It’s simpler that way.  It’s difficult to make all of the colors 

fit together unless you use as few as possible

Live well, it’s the greatest revenge.

Take a photograph of your favorite color. Crop it and add it to this page with 
a caption.
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Module 08

“Art resides in the quality of doing, process is 
not magic.” 

– Charles Eames
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P O N D E R  |  M O D U L E  08

When I need to take a break from 
homework my favorite thing to do is to 
do family history, play with Blender, or 
play Call of Duty Nazi Zombies

What makes a logo successful? 

It has to not only look good, but easily recognizable and 
memorable.

What did you learn about typography during this 
project? 

When creating a logo, it’s OK if you didn’t design your 
own font.

You have followed a basic design process for two 
projects now. What are the basic steps in a design 
process? 

Plan the design based on the name of the company/
product, sketch it out, draw it out, experiment with 
colors, etc.

What is your favorite step in the design process? 
Why? 

Drawing it.  I’m not very good at sketching.

Which step in the design process do you struggle 
with the most? Why?

Sketching, because it’s harder for me to be precise with a 
pencil than with a computer.

16 And he answered, Fear not: for 
they that be with us are more than 
they that be with them.

Take a photograph of your favorite distraction from homework. Crop it and 
add it to this page with a caption.
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Module 09

“Art is work.” 

– Milton Glaser
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P R O J E C T  |  P OS T ER S:  A R T I S T  R E SE A R CH

After choosing your artist from the Artist 
Sign-up list provided on iLearn, get to 
know them better by reading about 
them and looking at their work.

After completing the research on your artist provide 
the following information: 

BIOGRAPHY
Massimo Vignelli was born in January 10, 1931.  He 
studied architecture at the Politecnico di Milano and 
then at the Univerita di Architettura, Venice.  He started 
the New York branch of a newly organized company 
called Unimark International, and designed some of the 
most recognizable brands and signage, like for American 
Airlines and the New York City Subway system. He passed 
away in May 27, 2014.

HISTORICAL, TECHNOLOGICAL, AND SOCIAL CLIMATE
Postmodern art, deconstrunctionism, and pop art had 
drastically increased in popularity during his career.

ARTIST’S PHILOSOPHY
He was staunchly modern in a post-modern world.  He 
favored minimalism and often raged against typographic 
excess, claiming that a graphic designer shouldn’t need 
any more than five typefaces, though he later loosened 
the list to about a dozen.  He considered the design 
being central to the functionality of the object rather 
than the most fashionable aspect.

MAKING CONNECTIONS

[Write about what you have learned about design 
through studying your artist. Explain how learning about 
your artist’s work and ideas can help design students 
improve their own work today.]
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P R O J E C T  |  P OS T ER S:  A R T I S T  V I SUA L  R E SE A R CH  (CO N T I N U ED)
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P R O J E C T  |  P OS T ER S:  WO R D  L I S T S

A word list helps you explore ideas. 
Write every word you can think of that 
relates to your artist exhibit. Make sure 
you fill this page full of words. You 
may need the help of a thesaurus to 
complete this task. Once the page is full 
of words take some time to find and 
mark those words that could be turned 
into interesting poster sketches.

Lists

minimalist

functional

design

modern

simple

simplification

simplify

sleek

modernistic

modernist

helvetica

furnature

spoon

sofa

table

chair

handkerchief

powerful

elegant

comfortable

New York Subway

architect

house

American Airlines

unimark international

washington metro

Venice

Italy

practical

typeface
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P R O J E C T  |  P OS T ER S:  C AT EG O RY  & T H E M E

Complete this worksheet before you 
begin sketching your poster designs. 
Use this page to define the problem 
you will be solving in your sketches. The 
success of your posters will be assessed 
according to the information you 
provide here.

After completing the research on your artist provide 
the following information: 

ARTIST
Massimo Vignelli

EXHIBIT THEME OPTIONS
Modern, minimalist art favors functionality over passing 
fads in fashion

Simple shapes can be used to make functional and 
stylish furniture

EXHIBIT THEME

I’m going to explore how the style of Massimo Vignelli is 
both simplistic, stylistic, and functional.

EXHIBIT TAGLINE
Massimo vignelli: Modern Elegance

EMOTIONAL & RATIONAL CHARACTERISTICS
I want my poster to exhibit a similar style he constantly 
strove for in his work: the  simplicity, modernity, 
practicality, etc that would stand the test of time.



ART 130 | INTRODUCTION TO GRAPHIC DESIGN |  8AARON COWLEY

P R O J E C T  |  P OS T ER S:  M I N D  M A P

Identify interesting 
connections

1.	 Modern

2.	 simplicity

3.	 functionality

4.	 practicality

5.	 timelessness

6.	 geometry

7.	 italy

8.	 clear

9.	 minimalism

10.	firm

11.	logo

12.	italian

13.	European

14.	Eligant

15.	contemporary

16.	limited
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P R O J E C T  |  P OS T ER S:  SK E TCH E S

Identify interesting 
connections

1.	 caption

2.	 caption

3.	 caption

4.	 caption

5.	 caption
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P R O J E C T  |  P OS T ER S:  SK E TCH E S  (CO N T I N U ED)

Identify interesting 
connections

1.	 caption

2.	 caption

3.	 caption

4.	 caption

5.	 caption
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P R O J E C T  |  P OS T ER S:  SK E TCH E S  (CO N T I N U ED)

Identify interesting 
connections

1.	 caption

2.	 caption

3.	 caption

4.	 caption

5.	 caption
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P O N D E R  |  M O D U L E  09

My favorite thing to learn about is (fill in 
the blank).

Why do designers conduct research? 

We see what others have done, and we build off of it.  
There’s nothing really original under the sun.

What do you enjoy about researching? What parts do 
you struggle with? 

I struggle most with sketching.  I prefer to base them off 
of photos.

Why do designers brainstorm? 

Same reason you’d brainstorm any other time, to think of 
things you haven’t thought of before.

What do you enjoy about brainstorming? What parts 
of brainstorming do you struggle with? 

I really like to make decisions as quickly as possible, so 
brainstorming is something I need to work on.

How did your brainstorming help your sketching?

I have multiple ideas.  Sketch of the man?  Simple shapes 
to depict him?  His work?  Etc.

If you can design one thing, you 
can design everything.

Massimo Vignelli

Take a photograph of your favorite thing to learn about. Crop it and add it to 
this page with a caption.
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Module 10

“If you want to be as good as [Paul] Rand, 
don’t look at Rand; look at what Rand looks 
at.” 

– Helmut Krone



Directions:

1.	 Select View > Display Performance > High 
Quality Display from the drop-down menus 
above

2.	 Place the m10_activity_01_resolution_large 
file inside this image frame.

Note: This image is a high resolution image (300 pixels per inch) 
built to the size of this image frame.

Directions:

1.	 Open the m10_activity_01_resolution_small 
file in Adobe Photoshop.

2.	 Access the Image Size pop-up window by 
navigating to Image > Image Size in the drop-
down menus above.

3.	 Check to make sure the Width and Height 
fields are linked together (there should be a 
small dark gray link icon to the left of these 
fields).

4.	 Check to make sure the Resample check box is 
checked.

5.	 Type 5.94 in the Height field (the Width field 
should automatically change to 4.475 inches).

6.	 Save your photoshop file.

7.	 Place your modified m10_activity_01_
resolution_small file inside this image frame.  

8.	 Select this frame with the Selection Tool and 
then select Object > Fitting > Fit Content 
Proportionately from the drop-down menus 
above.

ART 130 | INTRODUCTION TO GRAPHIC DESIGN |  2AARON COWLEY

AC T I V I T Y  |  A D O B E  PH OTOSH O P:  FI L E  R E S O LU T I O N  PA R T  01

Place the m10_activity_01_resolution_large.psd file in the image frame above. Place the m10_activity_01_resolution_small.psd file in the image frame above. 
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AC T I V I T Y  |  A D O B E  PH OTOSH O P:  FI L E  R E S O LU T I O N  PA R T  02

After completing the activity on the 
previous page describe what you have 
learned about image resolution:

What is a pixel?

A pixel is a single dot representing a single color, 
composed of three sub pixels.  One for red, one for 
green, and one for blue.

What does pixels per inch (ppi) mean?

Um, how many pixels in a single inch?

How is the image of the camera on the right different 
from the image of the camera on the left (Note: 
both images began as the same original digital 
photograph)?

One started out high resolution and large size, the other 
is smaller and less resolution.

What happens to an image when you scale it up 
(increase the number of pixels per inch or increase 
the size of the file using the same number of pixels 
per inch) from its original image resolution?

The program tries and fails to fill in the gaps of what was 
there.  As a result, it looks hideous.
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AC T I V I T Y  |  A D O B E  PH OTOSH O P:  L AY ER S  PA L E T T E

Place the m10_activity_03_layers.psd file in the image frame above. 

Directions:

1.	 Open the m10_activity_03_resolution_small file in 
Adobe Photoshop.

2.	 Access the Layers palette for this file. You may 
need to access the Layers palette by navigating to 
Windows > Layers from the drop-down menus.

3.	 Rearrange the layers for this file so that Layer 0 is on 
the bottom, Layer 1 above it, Layer 2 above it, and 
Layer 3 as the top layer

4.	 Save your photoshop file.

5.	 Place your modified m10_activity_03_layers file 
inside the image frame on the left.  

6.	 Select this frame with the Selection Tool and 
then select Object > Fitting > Fit Content 
Proportionately from the drop-down menus above.



Directions:

1.	 Open the m10_activity_04_
adjustment_layers file in Adobe 
Photoshop.

2.	 Access both the Layers palette and the 
Adjustments palette for this file.

3.	 Add a Curves Adjustment Layer to this 
file and set new black and white points 
for the file.

4.	 Further adjust the curve for this file 
to add more darks at the low end and 
more lights at the high end.

5.	 Add a Hue and Saturation Adjustment 
Layer to the file and use the Master 
adjustment slider to eliminate the 
green tint to the image.

6.	 Save your photoshop file.

7.	 Place your modified  m10_activity_04_
adjustment_layers file inside this 
image frame.  

8.	 Select this frame with the Selection 
Tool and then select Object > Fitting 
> Fit Content Proportionately from the 
drop-down menus above.

ART 130 | INTRODUCTION TO GRAPHIC DESIGN |  5AARON COWLEY

AC T I V I T Y  |  A D O B E  PH OTOSH O P:  A DJ US T M EN T  L AY ER S

The m10_activity_04_adjustment_layers.psd file before layer adjustments are made. Place your modified m10_activity_04_adjustment_layers.psd file in the image frame above. 
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AC T I V I T Y  |  A D O B E  PH OTOSH O P:  L AY ER  M A SK S 

Place the m10_activity_05_layer_masks.psd file in the image frame above. 

Directions:

1.	 Open the m10_activity_05_layer_masks file in 
Adobe Photoshop.

2.	 Access the Layers palette for this file. 

3.	 Select the layer that contains the image of the letter 
a on a wood grain background.

4.	 Add a layer mask to that file and mask out the 
wood grain background of the image.

5.	 Save your photoshop file.

6.	 Place your modified m10_activity_05_layer_masks 
file inside the image frame on the left.  

7.	 Select this frame with the Selection Tool and 
then select Object > Fitting > Fit Content 
Proportionately from the drop-down menus above.
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P R O J E C T  |  P OS T ER S:  M O R E  G EN ER A L  P OS T ER  V I SUA L  R E SE A R CH
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P R O J E C T  |  P OS T ER S:  C AT EG O RY  & T H E M E  R E V I S I T ED

After receiving feedback from your 
peers and instructor revisit the theme 
you’ve chosen for your artist’s exhibit. 
Does this theme accurately portray your 
artist? Is your theme a clear message? Is 
it interesting?

After receiving feedback on your exhibit theme 
provide the following information:

EXHIBIT THEME REVISIONS

REVISED EXHIBIT TAGLINE
Design one thing, design everything

VISUAL METAPHORS AND OTHER IMAGE OPPORTUNITIES
[Provide a list of visual metaphors that could be used to 
represent your exhibit theme (you may need to look back 
at your word lists and mind maps from the last module). 
Describe ideas you have for making poster images using 
the visual metaphors you came up with.]

[Describe other image opportunities that you plan on 
exploring in your sketches to help illustrate your exhibit 
theme]

[Describe how you plan on using typography to express 
your image theme—especially for the typographic 
poster direction.]
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P R O J E C T  |  P OS T ER S:  SK E TCH E S  FO R  P OS T ER  D I R EC T I O N  01

Identify interesting 
connections

1.	 caption

2.	 caption

3.	 caption

4.	 caption

5.	 caption
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P R O J E C T  |  P OS T ER S:  SK E TCH E S  FO R  P OS T ER  D I R EC T I O N  02

Identify interesting 
connections

1.	 caption

2.	 caption

3.	 caption

4.	 caption

5.	 caption
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P R O J E C T  |  P OS T ER S:  SK E TCH E S  FO R  P OS T ER  D I R EC T I O N  03

Identify interesting 
connections

1.	 caption

2.	 caption

3.	 caption

4.	 caption

5.	 caption
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P R O J E C T  |  P OS T ER S:  V I SUA L  E XPER I M EN T S

Description for Visual 
Experiment 01

1.	 caption

2.	 caption

3.	 caption

4.	 caption
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P R O J E C T  |  P OS T ER S:  V I SUA L  E XPER I M EN T S

Description for Visual 
Experiment 02

1.	 caption

2.	 caption

3.	 caption

4.	 caption
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P R O J E C T  |  P OS T ER S:  V I SUA L  E XPER I M EN T S

Description for Visual 
Experiment 03

1.	 caption

2.	 caption

3.	 caption

4.	 caption
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P O N D E R  |  M O D U L E  10

My favorite example of my artist’s work 
is the furniture because It’s so sleek and 
modern, like the rest of his art.

How does understanding the theme of your exhibit 
influence your sketches? 

I want to emphasize that he’s a modernist designer, and 
that he takes it upon himself to design everything he can 
think of, not just graphics, but also things like maps or 
furniture.

What does the word Concept mean in graphic design? 

A concept is a solution to a problem

What did you learn about typography from working 
on your typographic poster? 

I don’t have to make my own font, I can use one that 
already exists

What did you learn from your visual experiments 
about making images outside the computer? 

I’m not taking my computer for granted ever again.

The life of a designer is a life of 
fight: a fight against the ugliness American Airlines
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Module 11

“Don’t try to be original, just try to be good.” 

– Paul Rand
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P R O J E C T  |  P OS T ER S:  R E V I SED  V I SUA L  E XPER I M EN T S

Description for Visual 
Experiment 01

1.	 caption

2.	 caption

3.	 caption

4.	 caption
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P R O J E C T  |  P OS T ER S:  A D D I T I O NA L  SK E TCH E S  A S  N EED ED

1

2

3

1.	 Using the numbered dots 
provided at the right mark those 
sketches you would like feedback 
on. 

2.	 Include a brief caption describing 
your concept for those posters.

3.	 Indicate specifically what you 
would like feedback on.
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P R O J E C T  |  P OS T ER S:  CO L L AG E  P OS T ER  D I G I TA L  CO M P S

1.	 Simplified vectorized photo of Massimo

2.	 Experimentation with different colored background

Ditto

Massimo Vignelli
Modern Elegance

Massimo Vignelli
Modern Elegance
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P R O J E C T  |  P OS T ER S:  T Y P O G R A PH Y  P OS T ER  D I G I TA L  CO M P S

1.	 Write a caption for your 1st digital comp selection. 

2.	 Write a caption for your 2nd selection. 

3.	 Write a caption for your 3rd selection. 

Massimo Vignelli

Modern Elegance

Massimo Vignelli

Modern Elegance

Massimo Vignelli

Modern Elegance
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P R O J E C T  |  P OS T ER S:  PH OTO G R A PH Y  P OS T ER  D I G I TA L  CO M P S

1.	 Write a caption for your 1st digital comp selection. 

2.	 Write a caption for your 2nd selection. 

3.	 Write a caption for your 3rd selection. 
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AC T I V I T Y  |  A D O B E  PH OTOSH O P:  CO M B I N I N G  I M AG E S

Place the m11_activity.psd file in the image frame above. 

Directions:

1.	 Open both the Art130_Activity_m11_01.JPG file 
and the Art130_Activity_m11_02.JPG file in Adobe 
Photoshop.

2.	 Using a layer mask, remove the background in the 
image of the young man.

3.	 Copy and paste the image of the young man into 
the file containing the image of the lake.

4.	 Use adjustment layers to adjust the image of the 
young man so it matches the lighting and contrast 
of the image of the lake.

5.	 Save your photoshop file as m11_activity.psd.

6.	 Place your m11_activity.psd file inside the image 
frame on the left.  

7.	 Select this frame with the Selection Tool and 
then select Object > Fitting > Fit Content 
Proportionately from the drop-down menus above.

+ =
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P O N D E R  |  M O D U L E  11

My favorite medium for making images 
depends on what kind of image I’m 
making because I find that inkscape 
and illustrator are best for logos and 
modern/postmodern illustrations, 
and gimp and photoshop I use for 
everything else.  However, I favor GIMP 
and Inkscape because they are free GNU 
programs.

Which mediums (paint, collage, photography, etc.) 
best communicate the theme of your exhibit? Why? 

Collage and construction paper, because simple shapes 
and colors are best for illustrating a poster dedicated to a 
modern, minimalist graphic designer.

What symbols have you chosen to communicate your 
exhibit theme? Why? 

Simple shapes, letters, and vectorized photos of massimo 
vignelli, because minimalism was how he worked.

What other symbols are you considering exploring? 

The furniture he also designed, will likely be vectorized 
photos.

What makes an image stand out on a poster? 

Contrast, simulated 3D, etc

If you can design one thing, you 
can design everything

Take a photograph of one of your visual experiments which uses your favorite 
medium. Crop it and add it to this page with a caption.
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Module 12

“Type is a beautiful group of letters, not a 
group of beautiful letters.” 

– Matthew Carter
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P R O J E C T  4 |  T Y PE  CH O I CE:  T Y PE  FO R  T H E  A R T I S T

FRANKLIN GOTHIC MEDIUM

A B C D E F G H I J K L M N O P Q R S T U V 
W X Y Z a b c d e f g h i j k l m n o p q r s t 
u v w x y z

The quick brown fox jumps over the lazy 
dog.

Brief description. Ipis et id molupta coreperio eos re re 
quia ped molupta speribu sandict urempor sum unt, 
qui consed molore con et quidebis dolo inctum fugit 
doluptam, sitat.

FRANKLIN GOTHIC BOOK

A B C D E F G H I J K L M N O P Q R S T U V 
W X Y Z a b c d e f g h i j k l m n o p q r s t 
u v w x y z

The quick brown fox jumps over the lazy 
dog.

Brief description. Itat ipsapiciate eventio rporibus eictet 
fuga. Is doluptaquam quae et adit, exerchicimin et ut 
fugita nam, sum rero modis repudis et modi consequi 
tendele

GILL SANS MT

A B C D E F G H I J K L M N O P Q R S T 
U V W X Y Z a b c d e f g h i j k l m n o p q 
r s t u v w x y z

The quick brown fox jumps over the lazy 
dog.

Brief description. Itat ipsapiciate eventio rporibus eictet 
fuga. Is doluptaquam quae et adit, exerchicimin et ut 
fugita nam, sum rero modis repudis et modi consequi 
tendele

CORBEL

A B C D E F G H I J K L M N O P Q R S T U V 
W X Y Z a b c d e f g h i j k l m n o p q r s t u v 
w x y z

The quick brown fox jumps over the lazy 
dog.

Brief description. Quia ped qui cus. Cae pla sinctotatet ra 
dolorit vendae verum fugit aut pa asitatem nonsedi aut 
ute volenda accabore aut unt unt elest, quam que eatur, 
qui aut

VER

A B C D E F G H I J K L M N O P Q R S 
T U V W X Y Z a b c d e f g h i j k l m n 
o p q r s t u v w x y z

The quick brown fox jumps over the 
lazy dog.

Brief description. Quia ped qui cus. Cae pla 
sinctotatet ra dolorit vendae verum fugit aut pa 
asitatem nonsedi aut ute

ESTRANGELO EDESSA

A B C D E F G H I J K L M N O P Q R S T U V W 
X Y Z a b c d e f g h i j k l m n o p q r s t u v w 
x y z

The quick brown fox jumps over the lazy dog.

Brief description. Ipis et id molupta coreperio eos re re quia 
ped molupta speribu sandict urempor sum unt, qui consed 
molore con et quidebis dolo inctum fugit doluptam, sitat.

DISPLAY FONT OPTIONS (FOR THE LARGE WORDS ON YOUR POSTERS)

BODY COPY FONT OPTIONS (FOR THE SMALLER WORDS ON YOUR POSTERS)
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Massimo Vignelli

Modern Elegance

Massimo Vignelli

Modern Elegance

Massimo Vignelli
Modern Elegance
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AC T I V I T Y  |  A D O B E  PH OTOSH O P:  FIX I N G  I M AG E S

Place the m12_activity.psd file in the image frame above. 

Directions:

1.	 Open the m12_Activity_Image_01.psd file in Adobe 
Photoshop.

2.	 Remove the scar on the model’s right cheek and 
the spot on his left cheek using the Healing Brush 
and/or the Coning Stamp tool.

3.	 Save your photoshop file as m12_activity_01.psd.

4.	 Place your m12_activity_01.psd file inside the image 
frame on the left.  

5.	 Select this frame with the Selection Tool and 
then select Object > Fitting > Fit Content 
Proportionately from the drop-down menus above.

=
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AC T I V I T Y  |  A D O B E  PH OTOSH O P:  M O R E  O N  M A SK I N G

Place the m12_activity.psd file in the image frame above. 

Directions:

1.	 Open the m12_Activity_Image_02.psd and m12_
Activity_Image_03.psd files in Adobe Photoshop.

2.	 Using the mask tools combine the images into a 
new file that looks like the example above.

3.	 Save your photoshop file as m12_activity_04.psd.

4.	 Place your m12_activity_04.psd file inside the 
image frame on the left.  

5.	 Select this frame with the Selection Tool and 
then select Object > Fitting > Fit Content 
Proportionately from the drop-down menus above.

=+
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Hi my name is Aaron Cowley and my 
most distinguishing feature is my 
hyperactivity

Where did you come from, before BYU-Idaho? 

American Heritage School, Family and Church History 
Headquarters Mission, etc

Why are you here, at BYU-Idaho? 

I was rejected from BYU Provo

Where are you going, after BYU-Idaho 

I hope to get a job with Ancestry, or do freelance for 
some smaller companies.

Why are you taking this class and what do you hope 
that it will do for you? 

I am hoping that it will make me a more effective visual 

designer for frontend web design.

What is “conscious incompetence” and how can 
understanding this idea help you be a better graphic 
designer?

It’s when you don’t know how to do something, and you 
are conscious of the deficit.  You keep making mistakes 
and learn from them, or listen to those who know what 
they are doing.

Styles come and go.  Good design 
is a language, not a style.

-Massimo Vignelli

Some letters from Jesus The Christ, a book I have studied during my mission.
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Module 13

“The details are not the details. They make 
the design.” 

– Charles Eames



Vertical Text BlockPoster Body Copy

Use this text to create each of the text blocks on the right. 
Make sure your text remains inside the white text block 
guidelines and that all of the information is visible.

Poster Logo

Add this logo to each of your text block designs on the 
right. Make sure it is also inside the white guidelines.

Three Column Text Block

Horizontal Text Block

Text Strips Text Block
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AC T I V I T Y  |  T Y P O G R A PH Y:  SHAPI N G  T E X T  B LO CK S

Modern Elegance 
Work by Massimo Vignelli
November 3 - December 31
Artist Reception on Saturday, November 3, 
6-9 pm
RSVP for reception to 800 235 8456 or 
exhibits@sfmoma.com
San Francisco Museum of Modern Art
151 Third Street (between Mission and 
Howard Streets)
San Francisco, CA 94103

Modern Elegance 
Work by Massimo Vignelli
November 3 - December 
31
Artist Reception on Satur-
day, November 3, 6-9 pm
RSVP for reception to 800 
235 8456 or exhibits@
sfmoma.com
San Francisco Museum of 
Modern Art
151 Third Street (between 
Mission and Howard 
Streets)
San Francisco, CA 94103

Modern Elegance 
Work by 

Massimo Vignelli
November 3 - December 31

Artist Reception on Saturday, 

November 3, 6-9 pm
RSVP for reception to 800 

235 8456 or exhibits@
sfmoma.com

San Francisco Museum of 
Modern Art

151 Third Street (between Mission 

and Howard Streets)

San Francisco, CA 94103

Modern Elegance Work by Massimo Vignelli
November 3 - December 31

Artist Reception on Saturday, November 3, 6-9 pm
RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art
151 Third Street (between Mission and Howard Streets) San Francisco, CA 94103

Modern Elegance Work by Massimo Vignelli November 3 - December 31
Artist Reception on Saturday, November 3, 6-9 pm RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art151 Third Street (between Mission and Howard Streets) San Francisco, CA 94103
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Refinements

1.	 Added text

2.	 Refined colors

Refinements

1.	 Some slight color adjustments

2.	 Refinement (…).

3.	 Refinement (…).

Refinements
1.	 Decided to match the posters I’ve seen on the internet.  In color scheme, 

that is.

2.	 Refinement (…).

3.	 Refinement (…).

MASSIMO VIGNELLI
Modern Elegance 

November 3 - December 31
Artist Reception on Saturday, November 3, 6-9 pm

RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art
151 Third Street (between Mission and 
Howard Streets)
San Francisco, CA 94103

MASSIMO VIGNELLI
Modern Elegance 

November 3 - December 31
Artist Reception on Saturday, November 3, 6-9 pm

RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art
151 Third Street (between Mission and 
Howard Streets)
San Francisco, CA 94103

MASSIMO VIGNELLI
Modern Elegance 

November 3 - December 31
Artist Reception on Saturday, November 3, 6-9 pm

RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art
151 Third Street (between Mission and 
Howard Streets)
San Francisco, CA 94103
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P R O J E C T  |  P OS T ER S:  FI NA L  R EFI N E M EN T S  FO R  P OS T ER  02 ( T Y P O G R A PH Y )

Refinements

1.	 Combined the text from previous assignments with word art

2.	 Refinement (…).

3.	 Refinement (…).

Refinements

1.	 Color adjustments

2.	 Refinement (…).

3.	 Refinement (…).

Refinements
1.	 Decided to match color scheme found in some of his work and posters 

referencing him.

2.	 Refinement (…).

3.	 Refinement (…).

Massimo Vignelli
Modern Elegance

November 3 - December 31

Artist Reception on Saturday, November 3, 6-9 pm
RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art
151 Third Street (between Mission and Howard Streets)

San Francisco, CA 94103

Massimo Vignelli
Modern Elegance

November 3 - December 31

Artist Reception on Saturday, November 3, 6-9 pm
RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art
151 Third Street (between Mission and Howard Streets)

San Francisco, CA 94103

Massimo Vignelli
Modern Elegance

November 3 - December 31

Artist Reception on Saturday, November 3, 6-9 pm
RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art
151 Third Street (between Mission and Howard Streets)

San Francisco, CA 94103
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P R O J E C T  |  P OS T ER S:  FI NA L  R EFI N E M EN T S  FO R  P OS T ER  03 (PH OTO G R A PH)

Refinements

1.	 Made this from scratch

2.	 Refinement (…).

3.	 Refinement (…).

Refinements

1.	 Color scheme matches his work

2.	 Refinement (…).

3.	 Refinement (…).

Refinements

1.	 Refinement (…).

2.	 Refinement (…).

3.	 Refinement (…).



ART 130 | INTRODUCTION TO GRAPHIC DESIGN |  6AARON COWLEY

P R O J E C T  |  P OS T ER S  PR E SEN TAT I O N

On the following pages I’ll be presenting 
posters that advertise an exhibit on 
Massimo Vignelli at the San Francisco 
Museum of Modern Art. The exhibit will 
focus on his graphic design and even his 
furniture designs.

Brief Biography 

He was born in January 10, 1931 and died May 27, 2014.  
He was a graphic designer, and an architect.

About the Artist’s Ideas and Philosophy 

He stuck to a modernist style in an increasing 
postmodern world.  He also expressed the belief that if a 
person can design one thing, they can design everything.  

He stuck to minimalism, believing that simplicity was the 
best way to design things.

About the Artist’s Work 

He was a modernist who designed logos and furniture 
with simple geometric shapes.

About the Exhibit 

It will include examples of his graphic design and his 
work in furniture design.

“Unfortunately, there are 
designers and marketing people 
who intentionally look down on 
the consumer with the notion that 
vulgarity has a definite appeal 

to the masses, and therefore 
they supply the market with a 
continuos flow of crude and vulgar 
design. I consider this action 
criminal since it is producing 
visual pollution that is degrading 
our environment just like all other 
types of pollution.” 

Massimo Vignelli Example of artist’s work Example of artist’s work Example of artist’s work
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P R O J E C T  |  F I NA L  P OS T ER  01 (CO L L AG E)

MASSIMO VIGNELLI
Modern Elegance 

November 3 - December 31
Artist Reception on Saturday, November 3, 6-9 pm

RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art
151 Third Street (between Mission and 
Howard Streets)
San Francisco, CA 94103

I used illustrator for this one.  I 
vectorized a photo of Massimo Vignelli, 
and drew some simple shapes to make 
it look like he’s going down a staircase.
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P R O J E C T  |  F I NA L  P OS T ER  02 ( T Y P O G R A PH Y )

Massimo Vignelli
Modern Elegance

November 3 - December 31

Artist Reception on Saturday, November 3, 6-9 pm
RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art
151 Third Street (between Mission and Howard Streets)

San Francisco, CA 94103

For this one, I tried to mimic his style 
and philosophy, and the color scheme 
I frequently saw when I looked for 
examples of his work.  The only objects 
on the poster that are not letters is 
the line beween the titles and the box 
surrounding the San Fransisco Museum 
of Modern Art icon.
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P R O J E C T  |  F I NA L  P OS T ER  03 (PH OTO G R A PH Y )

For this one, I tried to do the same thing 
I did for my collage poster, but I used 
physical objects instead, editing it in 
photoshop as necessary.
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When visually communicating an idea 
it’s important to make it both readable 
and.

What did you learn about the design process from 
this project? 

Start early!

Is it easier for you to come up with ideas or to create 
beautiful final images? Explain. 

It’s easier for me to do the final project.  I don’t do well 
with paper and pencil, I prefer tinkering with design 
programs.  If I were doing it the traditional way, it would 
be absolutely vital for me to get the sketch right, because 
I can’t erase or press ctrl-z when I’m working with a 
physical canvas and paint.  But with design programs, 
I can revise the design as much as I want without extra 
costs.  I can even use programs to do rough sketches, 
which makes it so much easier for me

What did you learn about paying attention to details 
from this project? 

Mostly color.  What color fits best?  Most colors 
combinations look like vomit, it’s best to fine one that 
doesn’t look like vomit.

What was the most important thing you feel you 
learned about design from this project? 

Combine your previous ideas into one if you must

“If you can design one thing, you 
can design everything.”

- Massimo Vignelli

Massimo Vignelli
Modern Elegance

November 3 - December 31

Artist Reception on Saturday, November 3, 6-9 pm
RSVP for reception to 800 235 8456 or exhibits@sfmoma.com

San Francisco Museum of Modern Art
151 Third Street (between Mission and Howard Streets)

San Francisco, CA 94103Massimo would have been proud of me
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